
¦ 2022 Vol. 18 no. 3

A Step-By-Step Tutorial for Performing a Moderated

Mediation Analysis using PROCESS

Leah Mary Clement
aB

and Meenakshie Bradley-Garcia
a

a
University of Ottawa

Abstract Interest in moderation and mediation models have gained momentum since the 1980s

and have become widespread in numerous fields of research including clinical, social, and health

psychology in addition to behavioral, educational, and organizational research. There are resources

available to help the user understand an analysis of a moderated mediation using the PROCESS

macro and its resultant output, however, many are in video format (e.g., YouTube) or lack detailed

instructions based on real world examples. To our knowledge, there are no resources that provide

a thorough yet accessible step-by-step explanation of the procedure involved in using PROCESS v4.1

to analyze and interpret a moderated mediation model using real data in SPSS v28. The aim of this

guide is to address this knowledge gap. An overview of mediation, moderation, and moderated me-

diation models is presented followed by instructions for verifying that assumptions are respected.

Finally, a procedure to analyze data using PROCESS v4.1 is presented along with an interpretation

of the resultant output.
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Introduction
In the field of psychology, researchers are often interested

in understanding whether different aspects of the human

experience (e.g., emotions, cognition, behaviours) are as-

sociated. However, to go beyond the exploration of such

associations, it is important to explore how they occur (i.e.,

mediation), and when they occur (i.e., moderation). Go-

ing one step further, understanding when one variable has

an effect on how an association between two other vari-

ables occurs (i.e., moderated mediation) can shed greater

light on the nature of a link between variables. Explor-

ing such complexities in associations between diverse con-

structs adds to our understanding of important phenom-

ena (e.g., depression, relationship satisfaction, memory),

and in turn, can increase our knowledge of how to man-

age said phenomena.

Researchers are sometimes faced with a lack of re-

sources or skills to test meaningful conceptual models of

associations between various phenomena. The purpose of

this tutorial is to demonstrate how to conduct a moderated

mediation analysis using Hayes’ PROCESS macro for SPSS

(Hayes, 2013, 2018). PROCESS is based on path analysis and

uses ordinary least squares (OLS) regression for continu-

ous outcomes and is an easy-to-use tool for analyzing mod-

els of moderated mediation. There are resources available

to assist users in performing an analysis of a moderated

mediation model using the PROCESS macro with SPSS and

its resultant output (e.g., YouTube). However, this tuto-

rial uses real data to provide a detailed yet simple, step-

by-step set of instructions for analyzing and interpreting

a moderated mediation model using PROCESS that is ac-

cessible to anyone with at least a beginner knowledge of

SPSS. We begin with an explanation of simple mediation,

moderation, and moderated mediation followed by a step-

by-step tutorial that includes instructions for verifying the

assumptions of a moderated mediation analysis, as well as

a procedure to analyze and interpret data using PROCESS

v4.1.
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Simple Mediation Model
Exploring whether an association exists between variables

involves the use of correlational analysis, such as bivari-

ate correlation. In this type of analysis, understanding

whether an independent variable influences a dependent

variable, such as in the case of prediction, is not of interest.

However, when it is important to understand which vari-

able is influencing the other (i.e., prediction), linear regres-

sion analysis is often used. To perform a linear regression

analysis, a researcher must choose an explanatory vari-

able (the independent variable, (IV or X)) and one or more

response variables (DV or Y). It is important to note that

simply performing a regression analysis does not provide

conclusive evidence on the influence of an IV on a DV. In

the case of a correlational research design, the choice of

an IV and DV to use for a regression analysis is based on a

theoretical framework. For instance, among couples who

have experienced a transgression in their relationship, en-

couraging the restoration of trust in the transgressor can

help the partner who has been hurt to forgive the trans-

gressor (Hammer & Hargrave, 2016). In this scenario, the

IV is trust in the transgressor, and the DV is forgiveness.

However, exploring the ways in which (i.e., how) trust in

the transgressor can help the partner who has been hurt

to forgive the transgressor may provide a deeper insight

into areas to target in couples’ therapy that could encour-

age trust and thereby forgiveness. Performing an analysis

of a simple mediation model can shed light on such areas

to target.

Similar to performing a linear regression involving an

IV and a DV, analysis of a simple mediation model involves

performing a regression-based analysis (Hayes, 2018). In

this model, the IV has an effect on an additional or third

variable termed amediator variable (M), which in turn has

an effect on the DV when the IV is held constant (Caron &

Valois, 2018; Gunzler, Chen, Wu, & Zhang, 2013). In other

words, the IV is associated with the DV through M. This

relationship is the indirect effect, which is the mediation

relationship. As an example, research shows that trust in

a romantic partner is associated with compassion for that

partner (Salazar, 2015), and compassion is also one of the

strongest predictors of forgiveness (Davis, 2017). There-

fore, it could be hypothesized that trust is associated with

forgiveness through compassion for a romantic partner.

Specifically, a mediational model could be tested wherein

trust in a romantic partner influences compassion for that

partner (a), and compassion for the partner influences for-
giveness of that partner (b), which would be the indirect ef-
fect of trust in a romantic partner on forgiveness through

compassion for the romantic partner (ab). Should an anal-
ysis of this model suggest that the indirect effect is signif-

icant, it could be concluded statistically that compassion

mediates the association between trust in a romantic part-

ner and forgiveness. If the indirect effect is not significant,

then there is no mediation, and it cannot be concluded that

compassion plays a role in the association between trust in

a romantic partner and forgiveness.

In addition to the indirect effect, a mediational model

also examines the direct effect of the IV on the DV. Continu-

ing with the scenario above, this would involve examining

whether trust in a romantic partner is associated with for-

giveness of that partner when compassion is held constant.

The direct effect (c′) and the indirect effect (ab) combined
are the total effect (c) of the mediation model as shown
in Figure 1A. Specifically, the indirect effect is the prod-

uct of the a path and the b path (a × b) while the total
effect is the sum of the indirect effect and the direct ef-

fect (c = c′ + a × b). For a detailed explanation of the
mathematical representation of a simple mediation rela-

tionship, as well as how to test a mediation model using

PROCESS, please refer to Kane and Ashbaugh (2017) and

Hayes (2018).

According to Meule (2019), there is a debate in the lit-

erature regarding the use of terms such as “complete me-

diation” (i.e., significant indirect effect and nonsignificant

direct effect), and “partial mediation” (i.e., significant in-

direct and direct effects). Meule (2019) also contends that

there is a debate in the literature regarding historical ap-

proaches (i.e., Baron & Kenny, 1986) causal steps approach

and contemporary approaches to deciding whether a sig-

nificant direct effect must be present for a significant in-

direct effect to be important. Moreover, Meule (2019) de-

scribes Hayes’ PROCESSmacro as a contemporary and sim-

ple way of analyzing a simple mediation model as it in-

volves two linear regressions. The first regresses M on

the IV (a), and the second regresses the DV on the IV (c′)
and M (b). Whether an indirect effect (or a mediation) ex-
ists is determined using bootstrap confidence intervals (CI),

wherein a confidence interval of the ab path that does not
include zero is considered suggestive of the presence of a

significant indirect effect.

Thus, analyzing a simplemediationmodel could help to

understand how compassion for a romantic partner is as-

sociated with trust in a romantic partner and forgiveness.

Equally important to examine is when trust in a romantic

partner is related to compassion for the partner, which in-

volves examining a moderation model.

Moderation Model
As in the case of a mediationmodel, regression-based anal-

ysis can be used to analyze a moderation model (Hayes,

2018). Here we are interested in determining whether a

third variable, or a moderator variable (W), influences the
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Figure 1 Panel A: Simple Mediation; panel B: Moderation; and panel C: Moderation Mediation Models. In panel A, the

dashed lines denote the indirect path (ab) while the solid line denotes the direct path (c′).

strength or direction of the association between the IV and

the DV. Specifically: “Identifying a moderator of an effect

helps to establish the boundary conditions of that effect or

the circumstances, stimuli, or type of people for which the

effect is large versus small, present versus absent, positive

versus negative, and so forth” (Hayes, 2018, p. 220).

From a statistical standpoint, testing a moderation

model is similar to testing the interaction between factors

in an analysis of variance (ANOVA; Frazier, Tix, & Barron,

2004). An interaction effect is present when the effect of

the IV on the DV is conditional upon W (Hayes, 2018). In

other words, we are interested in whether the association

between an IV and DV varies at different levels of W. Fig-

ure 1B demonstrates a conceptual diagram of amoderation

model. For a detailed explanation of the mathematical rep-

resentation of a moderation relationship, consult Caron,

Valois, and Gellen-Kamel (2020) and Lorah (2020, 2022).

For the procedure for analyzing a moderation model using

PROCESS, consult Hayes (2018).

Returning to the example of trust, compassion, and for-

giveness, researchers might be interested in understand-

ing when trust influences compassion. In the pursuit of

understanding healthy social behavior, humility has been

identified as important in the cultivation of compassion

(Worthington & Allison, 2018). Indeed, research has shown

that viewing a romantic partner as humble is associated

with also viewing them as compassionate (e.g., McDon-

ald, Olson, Goddard, & Marshall, 2018). Moreover, re-
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search has shown an association between trust and hu-

mility (e.g., Wang, Edwards, & Hill, 2017). A moderation

model could be hypothesized wherein the association be-

tween trust and compassion for a romantic partner is con-

ditional upon viewing the romantic partner as humble.

Moderated Mediation Model
Moderated mediation, a concept put forth by James and

Brett (1984), involves examining whether W influences the

magnitude of an indirect effect (Preacher, Rucker, & Hayes,

2007). Specifically, a moderated mediation relationship is

said to occur when a mediation relationship is dependent

upon the level of a moderator (Preacher et al., 2007). Fig-

ure 1C presents a conceptual model of moderated medi-

ation. Turning to our scenario involving trust, humility,

compassion, and forgiveness, a model of moderated me-

diation could be hypothesized wherein trust in a roman-

tic partner (X) is associated with forgiveness (Y) through

compassion for that partner (M), and this association is

strengthened by viewing that partner as humble (W).

Moderated Mediation Example
For this tutorial, we will be using data from a study that ex-

amined the association between dyadic trust, compassion

for the injuring partner, perception of the injuring partner

as humble, and forgiveness among individuals who expe-

rienced an attachment injury in their romantic relation-

ship. Attachment injuries are defined as a perceived viola-

tion of trust or abandonment that occurs during a critical

moment of need for the support and caring of a romantic

partner (Johnson, Makinen, & Millikin, 2001). In the study

discussed herein, dyadic trust refers to the degree of hon-

esty and goodwill the injured partner perceives the injur-

ing partner has toward them (Larzelere & Huston, 1980).

Integral to the resolution of attachment injuries and the

restoration of trust in a romantic relationship is forgive-

ness, which was defined in the study as when the injured

partner has high levels of benevolence motivations (e.g.,

goodwill) and low levels of motivations to avoid or seek re-

venge toward the injuring partner.

Participants

The sample used for this tutorial consisted of 138 indi-

viduals who reported experiencing an attachment injury

in their current romantic relationship for which they had

forgiven their partner. Participants were between the

ages of 18 and 62 (M = 22.59, SD = 7.68), and pre-
dominantly identified as female (84.1%) while the remain-

der identified as male (13.8%) and gender variant or non-

conforming (2.2%). The majority of participants identified

as White (58.0%) while the remainder identified as Asian

(20.3%), Black (10.9%), Arab (7.2%), First Nations, Métis,

or Inuit (2.2%), and Latinx or Hispanic (2.2%). Regarding

sexual orientation, participants identified as heterosexual

(75.4%), bisexual (14.5%), lesbian (3.6%), queer (3.6%), or

other (2.9%). Participants’ relationship duration ranged

from one month to 32 years (M = 2.96 years, SD = 5.17
years) and the majority of participants reported being in a

dating relationship (81.2%) and reported not currently liv-

ing with their romantic partner (74.6%).

To be eligible to participate in the study, participants

had to be at least 18 years of age, able to read and write

in English, have experienced an attachment injury as de-

fined by Johnson et al. (2001) in their current relationship,

and have reported forgiving their romantic partner for the

attachment injury. They also had to have been in the rela-

tionship for at least three months, which was considered a

minimum level of relationship stability. Participants con-

sisted of a combination of individuals living in the com-

munity and undergraduate students from a university in

Eastern Ontario.

Procedure

Once participants provided informed consent, they com-

pleted self-report questionnaires online via Qualtrics.
Participants completed a sociodemographic questionnaire

and were asked to briefly describe the attachment injury

and indicate whether or not they had forgiven their ro-

mantic partner for the attachment injury (yes/no). Dyadic

trust was measured using the Dyadic Trust Scale (DTS;

Larzelere & Huston, 1980), which consists of eight items

rated using a scale ranging from 1 (very strongly agree) to

7 (very strongly disagree). Compassion for a romantic part-

ner was measured using the Compassion Scale (CS; Pom-

mier, Neff, & Tóth-Király, 2020), which was modified to

be specific to the injured partner’s level of compassion to-

ward the injuring partner (e.g., “When my partner feels

sadness, I try to comfort him/her”). The CS consists of 16

items rated using a scale ranging from 1 (almost never) to

5 (almost always). To measure whether the injured part-

ner viewed the injuring partner as humble, the Relational

Humility Scale (RHS; Davis et al., 2011) was modified with

instructions that were specific to how the injured partner

viewed the injuring partner (i.e., “For the following ques-

tions, please indicate your current thoughts and feelings

about the person who hurt you; that is, we want to know

how you feel about that person right now. Next to each

item, chose the response that best describes your current

thoughts and feelings.”). The RHS consists of 16 items rated

from 1 (strongly disagree) to 5 (strongly agree). The injured

partner’s forgiveness of the injuring partner was rated us-

ing the Transgressions-related Interpersonal Motivations

Inventory (TRIM; McCullough et al., 1998; McCullough, Fin-

cham, & Tsang, 2003). The TRIM consists of three subscales
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that measure an individual’s motivation to avoid the per-

son who hurt them, motivation to seek revenge against the

person who hurt them, or motivation to appease and see

goodwill come to the person who hurt them. Participants

rated the 18 items using a scale that ranges from 1 (strongly

disagree) to 5 (strongly agree). Using the framework of the

TRIM-18, forgiveness was defined as low levels of motiva-

tion to avoid the injuring partner and seek revenge toward

him/her, and high levels of benevolence motivations to-

ward the injuring partner. For the purposes of this tuto-

rial, the example presented only includes the benevolence

subscale of the TRIM-18.

Steps for Performing a Moderated Mediation Analysis

Step 1: Material. The software required for this tutorial
includes version 28 of SPSS (IBM Corp., 2021) and the PRO-

CESS macro for SPSS (Hayes, 2013). This tutorial assumes

the reader has beginner-level knowledge of how to use

SPSS v28. To download the PROCESS macro for SPSS, and

for instructions on how to install it, visit processmacro.org.

The dataset used in this tutorial can be found on the jour-

nal’s website.

Step 2: Assumptions. As mentioned above, the moder-
ated mediation analysis we are presenting in this tutorial

involves regression analyses, which requires that the as-

sumptions necessary for performing regression analyses,

specifically multiple regression, are met. These assump-

tions involve ensuring the independence of observations,

linearity of relationships among the variables, error values

are homoscedastic, multicollinearity does not exist among

the IVs, and error values are normally distributed. A brief

description of each assumption is provided below. For

a detailed explanation of the different assumptions, see

Hayes (2018). To verify that these assumptions are re-

spected, we will perform a one-step procedure in SPSS v.28

that will provide all the output necessary to determine if

we can proceed with the moderated mediation analysis.

Begin by selecting Analyze > Regression >
Linear and move TRIM_Ben into the DV box, and
move DTST, CS_TOT, and RHSTOT into the IV box. In
the method box, ensure Enter is selected. Next, click
the Statistics button and ensure Estimates and
Confidence intervals (95%) are selected in the
Regression Coefficients section on the left panel. On the

right, ensure Model fit, Descriptives, Part
and partial correlations, and Collinearity
diagnostics are selected. In the Residuals sec-

tion below, ensure Durbin-Watson, Casewise
diagnostics, and Outliers outside: 3
standard deviations are selected, and then click on
Continue. Next, select the Plots button on the Linear
Regression dialogue box and ensure Histogram, Normal

probability plot, and Produce all partial plots are selected

and once again, select Continue. Next, click Save in the
Linear Regression dialogue box. In the Predicted Values

section on the left of the Linear Regression Save dialog

box, ensure Unstandardized is selected. In the Residuals

section on the right, ensure Studentized and Studentized

deleted are selected. Click Continue, and then Ok to
generate the predicted values and residuals. Three new

variables will be created and added to the dataset, namely,

PRE_1 (unstandardized predicted value), SRE_1 (studen-
tized residual), and SDR_1 (studentized deleted residual).

Independence

For the independence assumption to be met in regres-

sion, the residuals in the model must be independent.

This means that information about one participant cannot

influence information about another participant (Hayes,

2018). In our example, this would mean that the error

in estimation of one participant’s benevolence score does

not influence the error in estimation of another partic-

ipant’s benevolence score. To test this assumption, we

will use the Durbin-Watson statistic, which tests for the

presence of autocorrelation in error terms (Uyanto, 2020).

The Durbin-Watson statistic can vary between 0 and 4

(“Durbin–Watson Test,” 2008) with values in the range of

1.5 to 2.5 indicative that the assumption of independence

is met (Glen, 2022). To locate the Durbin-Watson statistic,

first locate and expand the Output and then the Regression

Dialogue on the left side of the SPSS output. Within the Re-

gression dialogue, you will find the Model Summary dia-

logue which contains the Durbin-Watson values. In our ex-

ample, the Durbin-Watson statistic is 2.035, which suggests

the assumption of independence of residuals is met. We

can now proceed to verifying the next assumption, which

is the assumption of linearity.

Linearity

A core assumption of regression is IVs are related to the

DV in a linear fashion such that as the IVs increase, the

values of the DV either increase or decrease. This assump-

tion can be tested by plotting the IVs and DV together or

by using partial plots to verify the linear relationship be-

tween each IV and the DV. We will outline how to verify if

the assumption of linearity is met by plotting all variables

together. However, the output generated provides the par-

tial plots for each IV, should the reader wish to verify the

assumption of normality for each IV independently. To

verify the assumption of linearity with the IVs and DV col-

lectively, we will generate a scatter plot using the SRE_1
(studentized residual) and PRE_1 (unstandardized pre-
dicted value) values. First, click on Graphs > Legacy
Dialogs > Scatter/Dot > Simple Scatter >
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Figure 2 Scatter diagram representing a linear relationship among all variables in the model.

Define. MovePRE_1 to the X-Axis box, andSRE_1 to the
Y-axis box, and click Ok. A new figure will be generated in

the SPSS output. Figure 2 shows the scatterplot generated

using the data provided with this tutorial. Through vi-

sual inspection, the data appear to be horizontal in nature,

which suggests the relationships between all variables in

the model are linear.

Homoscedasticity

The assumption of homoscedasticity involves ensuring

that the error that is present in the association between

the IVs and the DV is consistent across the scores of the

IVs. When the homoscedasticity assumption is violated,

heteroscedasticity is present, which means that the error

(the variability in the scores of the DV not attributable to

the IVs) differs in size across the different scores of the

DV (Osborne & Waters, 2002). To verify whether this as-

sumption is satisfied, we can refer to the same scatter plot

demonstrated in Figure 2. Recall that this is a plot of the

residuals in the model and using the same visual inspec-

tion of the scatter plot performed above, we conclude that

the residuals fit a rectangular shape. Thus, the error is

scattered randomly across the different values of the DV,

and the assumption of homoscedasticity is met. We can

now proceed to verifying whether the assumption of mul-

ticollinearity is met.

Multicollinearity

When two ormore IVs are correlated with each other, mul-

ticollinearity may exist, which suggests that the scores of

one or more IVs are determined by the other IVs in the

model (Kim, 2019). To test whethermulticollinearity exists,

we will verify the values of either the variance inflation

factor (VIF) or tolerance statistic generated in the SPSS out-

put. The VIF and tolerance statistics are reciprocals of one

another, so it is not necessary to check both values. The

rules of thumb for each are such that tolerance should not

be below 0.1 and VIF should not be above 10 (Miles, 2005).

In our example, the tolerance values for the IVs range be-

tween 0.631 and 0.918, thereforemulticollinearity does not

exist in our model. The tolerance values can be found in

the output view in SPSS by locating the Tolerance values

in the Collinearity Statistics table which is found in Output

/ Regression / Coefficients. We now proceed to testing the

assumption of normality.

Normality

The assumption of normality involves ensuring that the

residuals, or the errors in estimation, are normally dis-

tributed (Hayes, 2018). We will verify whether this as-

sumption has been met using plots that were generated in

our output at the beginning of Step 2. We first perform

a visual inspection of the histogram with a superimposed

normality curve in Figure 3 which suggests that our data

are somewhat negatively skewed.

Next, we visually inspect the P-P plot in Figure 4, which

shows that the points are not perfectly aligned along the di-

agonal line and therefore the data is not normal. However,

regression is robust against non-severe violations of nor-

mality (Hayes, 2018), thus the data will not be transformed,

The Quantitative Methods for Psychology 2632

https://www.tqmp.org
https://crossmark.crossref.org/dialog/?doi=10.20982/tqmp.18.3.p258


¦ 2022 Vol. 18 no. 3

Figure 3 Histogram with normality curve.

and the moderated-mediation analysis will proceed.

Step 3: PROCESS Model 7 Moderated-Mediation Analy-
sis. Since the data does not severely violate the assump-
tions of multiple regression analysis, we can proceed with

the moderated-mediation analysis. For this example, Y is

the total scores of benevolence motivations (TRIM_Ben),
X is the total dyadic trust scores (DTST), M is the total com-
passion for the injuring partner scores (CS_TOT), and W
is the total perception of the injuring partner as humble

scores (RHSTOT). To perform amoderated mediation anal-
ysis using PROCESS, select Analyze > Regression
> PROCESS v4.1 by Andrew F. Hayes. In the

PROCESS_v4.1 dialogue box, drag the TRIM_Ben into
the Y variable window, DTST into the X variable box,
CS_TOT into the Mediators(s) M box, and RHSTOT into the
Moderator variable W box. In the Model Number drop-

down box, select number 7 and in the remaining drop-

downmenus, select a confidence interval of 95%, and 5000

bootstraps (or more, but the analyses will take longer). The

bootstrap valuemay be increased depending on the level of

precision the user would like to obtain in the estimation of

the limits of a confidence interval. As the number of boot-

strap samples increases, the variability in the estimation of

the limits of a confidence interval decreases (Hayes, 2018).

The types of analysis to conduct in PROCESS can

be programmed by following the subsequent steps.

First, click Options and then select Generate
code for visualizing interactions to gen-

erate graphs of the interactions between the variables,

Pairwise contrasts of indirect effects
to compare the indirect effects of the moderator

on the mediator, and the DV and IV. Under the

Heteroscedasticity-consistent inference
drop-down menu select HC4 (Cribari-Neto) to mea-
sure the standard error. In the Conditional values
section in the bottom right, select -1SD, Mean, +1SD
to view the results of the moderator at 1 standard devia-

tion below and above the mean, and select Continue. In
the PROCESS_v4.1 dialogue box, click Ok to generate the
output which can be found under Output > Matrix in the

SPSS output window. This output has also been included

in this tutorial, see Appendix 1.

Moderated-Mediation Data Interpretation
Step 4: Data Interpretation. The PROCESS output pro-
vides a comprehensive analysis of the data categorized into

moderation, mediation, and moderated mediation output

(Appendix 1). Before starting the analysis, confirm that the

model was correctly generated by reviewing the IV, DV, W,

and M variables as well as the sample size (lines 6 to 11).

Also, ensure that there are no error messages that appear

between lines 100 and 104. If variables were correctly an-

alyzed and no error messages appear, then proceed with

the subsequent steps.

Moderation Analysis
To determine if a moderation relationship exists between

the IV and M, we need to interpret the model summary
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Figure 4 Normal P-P plot.

table for the Outcome Variable CS_TOT (compassion for
injuring partner). This table is found from lines 13 to 21

of the SPSS PROCESS Output in Appendix 1. Within this

table, there is a Model Summary section that provides
the output necessary for determining if there are main

effects of RHSTOT (W; perception of injuring partner as
humble) and DTST (X; dyadic trust) as well as an inter-
action of these two variables on CS_TOT (M; lines 13 to
16). This can be determined by reviewing the p-value on

line 16. As shown in the example, this model is significant

(p = .0008) suggesting that there is a main effect and/or
an interaction of RHSTOT (W) on the relationship between
DTST (X) and CS_TOT (M). As this model is significant, it
is important to determine which of the X and W variables

contribute to the significant effect in this model. For this,

determine if the p-value is below or above .05 and if the

null of 0 falls between the confidence intervals for X and

W. In this example, there were no main effects of dyadic

trust (b = −.517, t = −1.8519, p = .0662; line 19) or the
perception of the injuring partner as humble (b = −.3549,
t = −1.47, p = .1439; line 20). However, there was a
significant interaction (a path: b = .0143, t = 2.3107,

p = .0224, line 21) which was also observed as the null
of 0 does not fall between the confidence interval [0.0021,

0.0265]. The Test(s) of highest order unconditional interac-

tion(s) table from lines 29 to 31 provides the r2 change re-

flecting the variance that the interaction explains. In this

case, the RSTOT (W) explains 3.5% of the variance in the

interaction between the DTST (X) and CS_TOT (M). Re-
turning to our example, this suggests that the association

between dyadic trust (X) and compassion for the injuring

partner (M) is moderated by the perception of the injuring

partner as humble (W).

As this interaction is significant, we can review the

simple slopes to visualize this interaction between X on

different levels of W, specifically at 1 SD below and above
the mean, and at the mean. To visualize the interactions,

select and copy all the lines of code from the PROCESS out-

put (lines 43 to 56) and then paste these lines in a new

syntax in SPSS by selecting File > New > Syntax.
You are now ready to select Execute to generate a figure
of the simple slopes of the interaction of RHSTOT (W) on
the association between DTST (X) and CS_TOT (Y). The
figure generated will not contain a fit line thereby making
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Figure 5 Simple slopes demonstrating the interaction of the moderation analysis.

it difficult to visualize the slopes. Therefore, to add this

fit line, double-click on the figure that was created in the

previous step and then select Elements > Fit Line
at Subgroups. The fit line should now appear in your
figure. The significance level at each of the three levels

of RHSTOT is found in the Conditional effects of
the focal predictor at the values of the
moderator(s) table from lines 36 to 40. For the example
used in this tutorial, compassion for the injuring partner

(M) and dyadic trust (X) varies according to the extent to

which the injured partner perceives the injuring partner

as humble. Specifically, there is no significant association

when the injured partner barely and moderately perceive

the injuring partner as humble (p = .2571 and p = .6368;
lines 39 and 38, respectively). In contrast, there is a sig-

nificant effect of dyadic trust (X) and compassion for the

injuring partner (M) when the injured partner perceives

the injuring partner as highly humble (W, p = .0222; line
40). In Figure 5 below, the lower, average, and higher

levels of RHSTOT are denoted by 32.73, 42.92, and 53.11,
respectively.

Mediation Analysis

Now, we need to determine if there is a direct association

between X and Y. To do this, we interpret the model sum-

mary in the Outcome Variable section for outcome variable

TRIM_Ben (lines 59 to 67). According to the Outcome Vari-
able – TRIM_Ben table found on lines 60 to 62, this model
is significant (p < .0001; line 62). When looking at the
R-squared value of the model summary, we can establish

the variance explained by the predictors (X and M) on Y

(line 62). In this case, the two predictors (e.g., DTST and
CS_TOT) account for 31.8% of the variance of forgiveness
(Y). Specifically, there is a significant direct effect [c′ path:
t(135) = 3.6509, p = .0004] as well as a significant indi-
rect effect [ab path: t(135) = 5.9916, p = .0000] of X on Y.
The c′ and ab paths can be established by reviewing lines
67 and 66, respectively. The Direct effect of X on
Y and Conditional Indirect Effects of X on
Y are tables from lines 77-79 and 80-86, respectively. In
this example, the null of 0 does not fall between the lower

and upper limit of the 95% confidence interval for the IV

[.0678, .2281; line 79] and at each level of M [.1954, .3880;

line 67]. Therefore, there is a statistically significant effect

of the level of dyadic trust on having compassion for the in-

juring partner, and of having compassion for the injuring

partner on forgiveness.

Moderated Mediation Analysis
The Index of moderated mediation table pro-

vides information to determine if there is a significant

moderated mediation following bootstrapping (lines 87 to

89). As seen in the output for this tutorial, the perception of

the injuring partner as humble significantly moderates the

indirect effect of dyadic trust (X) on forgiveness (Y) through

compassion for the injuring partner (M), [CI = .0001 – .0077,

line 89]. Therefore, there is evidence of a moderated medi-

ation with this data.

Finally, the Bootstrap results for the
regression model parameters table provide the
confidence intervals for the a, b, and c′ paths (lines 95 to
106). For this example, the interaction of RHSTOT on the
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association between DTST and CS_TOT is significant [CI
= .0005, .0252, line 101]. The direct and indirect effects of

DTST and CS_TOT on TRIM_Ben were also significant
[CI = .0584, .2288 and .1920, .3885; lines 105 and 106 re-

spectively]. We now turn to an example of how we would

report the results of our moderation mediation analysis.

Step 5: Reporting results. Using the scenario for this tu-
torial to report the statistical findings, we conclude that

there is a significant moderation effect of the perception of

the injuring partner as humble (W) on the association be-

tween dyadic trust (X) and forgiveness (Y) through compas-

sion for the injuring partner (M) [a path; t(134) = 2.3107,
p = .0224]. Additionally, compassion for the injuring
partner (M) has a significant effect on forgiveness (Y) [b
path; t(135) = 5.9916, p < .0001]; however, dyadic trust
(X) does not have a significant direct effect on forgiveness

(Y) [c′ path; t(135) = 3.6509, p = .0678]. Overall, this
model indicates a statistically significant moderated me-

diation. This suggests that the perception of the injuring

partner as humble significantly moderates the indirect ef-

fect of dyadic trust on forgiveness through compassion for

the injuring partner [CI = .0001, .0077]. These findings are

demonstrated in Figure 6.

Discussion
This tutorial provided step-by-step instructions for exam-

ining a moderated mediation model using PROCESS v4.1

for SPSS v28, and for analyzing the resultant output.

A moderated mediation allows researchers to examine

whether a mediation functions in a similar manner, or al-

together differently, across varying groups of individuals

(Jose, 2013). Although SEM is the most well-known statisti-

cal analysis for moderated mediation models (Hayes, Mon-

toya, & Rockwood, 2017), other less complicated statistical

analyses exist such as Hayes (2018) PROCESS macro for
SPSS. While it can be seen from this tutorial that PROCESS

is a simple, user-friendly statistical tool, it does have limi-

tations that should be considered before it is incorporated

into a statistical analysis strategy.

As mentioned above, PROCESS is not designed to be

used with latent variables and Hayes (2020) suggests using

Mplus to analyze models involving such variables. While

specializing in models involving observed variables can

be an advantage, it also has limitations including the po-

tential for measurement error in the predictor variables,

outcomes, and linear models (Hayes, 2012). With respect

to moderated mediation models involving more than one

mediator, PROCESS does not offer a model that combines

moderation with serial multiple mediations (Hayes, 2012).

Despite these limitations, PROCESS can be used to analyze

several models of conditional processes beyond what this

tutorial has demonstrated.

Conclusion
This tutorial presented instructions for using PROCESS

with respect to a basic model of a moderated mediation

(i.e., Model 7; Hayes, 2018) which serves as a useful start-

ing point for understanding how to perform more com-

plex models. We encourage the user to refer to Hayes

(2018) for examples of complex conditional process mod-

els (e.g., double moderated mediation models). We hope

that this tutorial inspires the development of more user-

friendly methods for performing conditional process anal-

yses along with easy-to-understand instructions for their

use.

Authors’ note
We wish to thank Marie-France Lafontaine who provided

the database from which the moderated mediation exam-

ple is derived.
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Brown, M. C. Worline, C. D. Cameron, & J. R. Doty

(Eds.), The oxford handbook of compassion science

(Vol. Vol. 1, pp. 1–99). doi:10 . 1093 / oxfordhb /

9780190464684.013.23

Durbin–Watson Test. (2008), In The concise encyclopedia of

statistics (pp. 173–175). doi:10.1007/978-0-387-32833-

1_122

Frazier, P. A., Tix, A. P., & Barron, K. E. (2004). Testing mod-

erator and mediator effects in counseling psychol-

ogy research. Journal of Counseling Psychology, 51(1),

115–134. doi:10.1037/0022-0167.51.1.115

The Quantitative Methods for Psychology 2672

https://www.tqmp.org
https://crossmark.crossref.org/dialog/?doi=10.20982/tqmp.18.3.p258
https://dx.doi.org/10.1037/0022-3514.51.6.1173
https://dx.doi.org/10.20982/tqmp.14.2.p147
https://dx.doi.org/10.20982/tqmp.14.2.p147
https://dx.doi.org/10.20982/tqmp.16.1.p009
https://dx.doi.org/10.1080/00223891.2011.558871
https://dx.doi.org/10.1080/00223891.2011.558871
https://dx.doi.org/10.1093/oxfordhb/9780190464684.013.23
https://dx.doi.org/10.1093/oxfordhb/9780190464684.013.23
https://dx.doi.org/10.1007/978-0-387-32833-1_122
https://dx.doi.org/10.1007/978-0-387-32833-1_122
https://dx.doi.org/10.1037/0022-0167.51.1.115


¦ 2022 Vol. 18 no. 3

Figure 6 Conceptualization of model 7 moderated mediation for fictional example.

Glen, S. (2022). Durbin Watson Test & Test Statistic"

From StatisticsHowTo.com: Elementary Statistics for

the rest of us! Retrieved from https : / / www .

statisticshowto.com/durbin-watson-test-coefficient/

Gunzler, D., Chen, T., Wu, P., & Zhang, H. (2013). Introduc-

tion to mediation analysis with structural equation

modeling. Shanghai Archives of Psychiatry, 25(6), 390–

394. doi:10.3969/j.issn.1002-0829.2013.06.009

Hammer, M. Y., & Hargrave, T. D. (2016). Forgiveness in

couples therapy. In G. R. Weeks, S. T. Fife, & C. M. Pe-

terson (Eds.), Techniques for the couple therapist (1st

ed (pp. 186–189). Paris: Routledge.

Hayes, A. F. (2012). Process: A versatile computational

tool for observed variable mediation, moderation,

and conditional process modeling. Retrieved August

8, 2020, from http : / / www . afhayes . com / public /

process2012.pdf

Hayes, A. F. (2013). Introduction to mediation, moderation,

and conditional process analysis: A regression-based

approach. Paris: Guilford Press.

Hayes, A. F. (2018). Introduction to mediation, moderation,

and conditional process analysis: A regression-based

approach (second edition). Paris: Guilford Press.

Hayes, A. F. (2020). Statistical methods for communication

science. Washington: Routledge.

Hayes, A. F., Montoya, A. K., & Rockwood, N. J. (2017).

The analysis of mechanisms and their contingencies:

Process versus structural equation modeling. Aus-

tralasian Marketing Journal, 25(1), 76–81. doi:10.1016/

j.ausmj.2017.02.001

James, L. R., & Brett, J. M. (1984). Mediators, moderators,

and tests formediation. Journal of Applied Psychology,

69(2), 307–321. doi:10.1037/0021-9010.69.2.307

Johnson, S. M., Makinen, J. A., & Millikin, J. W. (2001). At-

tachment injuries in couple relationships: A new per-

spective on impasses in couples therapy. Journal of

Marital and Family Therapy, 27(2), 145–155. doi:10 .

1111/j.1752-0606.2001.tb01152.x

Jose, P. E. (2013). Doing statistical mediation and modera-

tion. Washington: Guilford Press.

Kane, L., & Ashbaugh, A. R. (2017). Simple and parallel me-

diation: A tutorial exploring anxiety sensitivity, sen-

sation seeking, and gender. The Quantitative Methods

for Psychology, 13(3), 148–165. doi:10.20982/tqmp.13.

3.p148

Kim, J. H. (2019). Multicollinearity and misleading statis-

tical results. Korean Journal of Anesthesiology, 72(6),

558–569. doi:10.4097/kja.19087

Lorah, J. A. (2020). Interpretation of main effects in the

presence of non-significant interaction effects. The

Quantitative Methods for Psychology, 16(1), 33–45.

doi:10.20982/tqmp.16.1.p033

Lorah, J. A. (2022). Interpretation and visualization of mod-

eration effects and random slopes in multilevel mod-

els. The Quantitative Methods for Psychology, 18(1),

111–127. doi:10.20982/tqmp.18.1.p111

McCullough, M. E., Fincham, F. D., & Tsang, J.-A. (2003).

Forgiveness, forbearance, and time: The temporal un-

folding of transgression-related interpersonal moti-

vations. Journal of Personality and Social Psychology,

84(3), 540–557. doi:10.1037/0022-3514.84.3.540

The Quantitative Methods for Psychology 2682

https://www.tqmp.org
https://crossmark.crossref.org/dialog/?doi=10.20982/tqmp.18.3.p258
https://www.statisticshowto.com/durbin-watson-test-coefficient/
https://www.statisticshowto.com/durbin-watson-test-coefficient/
https://dx.doi.org/10.3969/j.issn.1002-0829.2013.06.009
http://www.afhayes.com/public/process2012.pdf
http://www.afhayes.com/public/process2012.pdf
https://dx.doi.org/10.1016/j.ausmj.2017.02.001
https://dx.doi.org/10.1016/j.ausmj.2017.02.001
https://dx.doi.org/10.1037/0021-9010.69.2.307
https://dx.doi.org/10.1111/j.1752-0606.2001.tb01152.x
https://dx.doi.org/10.1111/j.1752-0606.2001.tb01152.x
https://dx.doi.org/10.20982/tqmp.13.3.p148
https://dx.doi.org/10.20982/tqmp.13.3.p148
https://dx.doi.org/10.4097/kja.19087
https://dx.doi.org/10.20982/tqmp.16.1.p033
https://dx.doi.org/10.20982/tqmp.18.1.p111
https://dx.doi.org/10.1037/0022-3514.84.3.540


¦ 2022 Vol. 18 no. 3

McCullough, M. E., Rachal, K. C., Sandage, S. J., Worthing-

ton, E. L., Brown, S. W., & Hight, T. L. (1998). Interper-

sonal forgiving in close relationships: Ii. theoretical

elaboration and measurement. Journal of Personality

and Social Psychology, 75(6), 1586–1603. doi:10.1037/

0022-3514.75.6.1586

McDonald, J. E., Olson, J. R., Goddard, H. W., & Mar-

shall, J. P. (2018). Impact of self-transcendent and self-

enhancement values on compassion, humility, and

positivity inmarital relationships. Counseling and Val-

ues, 63(2), 194–209. doi:10.1002/cvj.12088

Meule, A. (2019). Contemporary understanding of media-

tion testing. Meta-Psychology, 3, 1–99. doi:10 .15626 /

MP.2018.870

Miles, J. (2005). Tolerance and variance inflation factor.

In B. S. Everitt & D. C. Howell (Eds.), Encyclopedia

of statistics in behavioral science (p (pp. 99–999). Ltd:

John Wiley & Sons.

Osborne, J. W., & Waters, E. (2002). Four assumptions of

multiple regression that researchers should always

test. Practical Assessment, Research, and Evaluatio, 8,

2–2. doi:10.7275/R222-HV23

Pommier, E., Neff, K. D., & Tóth-Király, I. (2020).
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Appendix 1: PROCESS Output in SPSS
1 Run MATRIX procedure:
2 ***************** PROCESS Procedure for SPSS Version 4.1 *****************
3 Written by Andrew F. Hayes, Ph.D. www.afhayes.com Documentation available in Hayes (2022). www.

guilford.com/p/hayes3
4 **************************************************************************
5 Model : 7
6 Y : TRIM_Ben
7 X : DTST
8 M : CS_TOT
9 W : RHSTOT
10 SampleSize: 138
11 **************************************************************************
12 OUTCOME VARIABLE: CS_TOT
13 Model Summary
14 R R-sq MSE F df1 df2 p
15 .3426 .1174 65.6657 5.9386 3.0000 134.0000 .0008
16 Model coeff se t p LLCI ULCI
17 constant 74.8582 9.9030 7.5591 .0000 55.2718 94.4447
18 DTST -.5170 .2792 -1.8519 .0662 -1.0691 .0352
19 RHSTOT -.3549 .2414 -1.4700 .1439 -.8323 .1226
20 Int_1 .0143 .0062 2.3107 .0224 .0021 .0265
21 Product terms key: Int_1 : DTST x RHSTOT
22 Covariance matrix of regression parameter estimates:
23 constant DTST RHSTOT Int_1
24 constant 98.0696 -2.5880 -2.2642 .0579
25 DTST -2.5880 .0779 .0560 -.0016
26 RHSTOT -2.2642 .0560 .0583 -.0014
27 Int_1 .0579 -.0016 -.0014 .0000
28 Test(s) of highest order unconditional interaction(s):
29 R2-chng F df1 df2 p
30 X*W .0352 5.3392 1.0000 134.0000 .0224
31
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32 Focal predict: DTST (X)
33 Mod var: RHSTOT (W)
34

35 Conditional effects of the focal predictor at values of the moderator(s):
36 RHSTOT Effect se t p LLCI ULCI
37 32.7287 -.0500 .1056 -.4733 .6368 -.2588 .1589
38 42.9203 .0955 .0839 1.1381 .2571 -.0704 .2613
39 53.1119 .2409 .1041 2.3135 .0222 .0349 .4468
40 Data for visualizing the conditional effect of the focal predictor: Paste the text below into a SPSS

syntax window and execute to produce plot.
41 DATA LIST FREE/ DTST RHSTOT CS_TOT .
42 BEGIN DATA.
43 28.3443 32.7287 61.8276
44 38.5942 32.7287 61.3154
45 48.8441 32.7287 60.8032
46 28.3443 42.9203 62.3331
47 38.5942 42.9203 63.3114
48 48.8441 42.9203 64.2898
49 28.3443 53.1119 62.8385
50 38.5942 53.1119 65.3074
51 48.8441 53.1119 67.7764
52 END DATA.
53 GRAPH/SCATTERPLOT=
54 DTST WITH CS_TOT BY RHSTOT
55

56 **************************************************************************
57 OUTCOME VARIABLE: TRIM_Ben
58 Model Summary
59 R R-sq MSE df1 df2 p
60 .5645 .3186 22.3035 31.5673 2.0000 135.0000 .0000
61 Model
62 coeff se t p LLCI ULCI
63 constant -2.5780 3.1714 -.8129 .4177 -8.8500 3.6940
64 DTST .1479 .0405 3.6509 .0004 .0678 .2281
65 CS_TOT .2917 .0487 5.9916 .0000 .1954 .3880
66 Covariance matrix of regression parameter estimates:
67 constant DTST CS_TOT
68 constant 10.0576 -.0334 -.1341
69 DTST -.0334 .0016 -.0005
70 CS_TOT -.1341 -.0005 .0024
71 Test(s) of X by M interaction:
72 F df1 df2 p
73 .4658 1.0000 134.0000 .4961
74 ****************** DIRECT AND INDIRECT EFFECTS OF X ON Y *****************
75 Direct effect of X on Y
76 Effect se t p LLCI ULCI
77 .1479 .0405 3.6509 .0004 .0678 .2281
78 Conditional indirect effects of X on Y:
79 INDIRECT EFFECT:
80 DTST -> CS_TOT -> TRIM_Ben
81 RHSTOT Effect BootSE BootLLCI BootULCI
82 32.7287 -.0146 .0352 -.0827 .0570
83 42.9203 .0278 .0253 -.0200 .0795
84 53.1119 .0703 .0283 .0193 .1307
85 Index of moderated mediation:
86 Index BootSE BootLLCI BootULCI
87 RHSTOT .0042 .0019 .0001 .0077
88 Pairwise contrasts between conditional indirect effects (Effect1 minus Effect2)
89 Effect1 Effect2 Contrast BootSE BootLLCI BootULCI
90 .0278 -.0146 .0424 .0195 .0014 .0784
91 .0703 -.0146 .0848 .0389 .0029 .1568
92 .0703 .0278 .0424 .0195 .0014 .0784
93 *********** BOOTSTRAP RESULTS FOR REGRESSION MODEL PARAMETERS ************
94 OUTCOME VARIABLE: CS_TOT
95 Coeff BootMean BootSE BootLLCI BootULCI
96 constant 74.8582 73.8614 10.7387 49.0463 91.7395
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97 DTST -.5170 -.4965 .2944 -1.0333 .1395
98 RHSTOT -.3549 -.3371 .2477 -.7660 .2078
99 Int_1 .0143 .0139 .0062 .0005 .0252
100 OUTCOME VARIABLE: TRIM_Ben
101 Coeff BootMean BootSE BootLLCI BootULCI
102 constant -2.5780 -2.5068 3.1786 -8.6323 3.8387
103 DTST .1479 .1468 .0437 .0584 .2288
104 CS_TOT .2917 .2914 .0504 .1920 .3885
105 *********************** ANALYSIS NOTES AND ERRORS ************************
106 Level of confidence for all confidence intervals in output: 95.0000
107 Number of bootstrap samples for percentile bootstrap confidence intervals: 10000
108 W values in conditional tables are the mean and +/- SD from the mean.
109 ------ END MATRIX -----
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